
NetEditorLite User Manual 

 

Foreword 

NetEditorLite is a program that can extract circuit data based on image of chip. It supports 

automatic or human-computer interactive ways to extract circuit data which is faithful to the chip 

image. It also can export Verilog or Edif200 file that can be imported into Synopsys, Cadence and 

other EDA software for redesign. 
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Chapter 1 Requirements 

 1.1 Operating System Requirements  

NetEditorLite can be running under the following operating systems: 

(1) Windows 2000 

(2) Windows 2003 

(3) Windows XP 

The recommended operating systems are as follows: 

Server: Windows Server 2003 

Clients: Windows XP Professional 

1.2 Hardware Configuration Requirements  

(1) CPU: Pentium IV 1.6G or above  

(2) 256M RAM or more 

(3) 40G hard disk or higher  

(4) 1024 × 768 screen resolution or larger 
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Chapter 2 Installation steps 

2.1 Installation file describes   

 NetEditorLiteSetup.msi: installation package, installing the NetEditorLiteSetup program for 

extract netlist data. 

2.2 Installation and Open a project 

1. Executive NetEditorLiteSetup.msi, according to the installation wizard prompts, step by 

step installation. 

2. After installation has been complete, click desktop shortcut NetEidtorLite, as shown 

below: 
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Click menu "File", select "Load Background Image", as shown below: 

 

 

 

Select image file(". icf"), then click "Open", as shown below: 
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Click menu "File" and select "Open Main Macro…", the image show in the work window, as 

shown below: 

 

 

 

Open a project end. 
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Chapter 3 Interface introduction 

  Click icon (Create a top macro cell), as shown below. The interface includes the 

following sections: menu bar, tool bar, status bar, multilayer image navigation window, work 

window, cell list, output window and radar window for positioning. 

 

               menu bar          tool bar           work window      cell list 

 

 

 

image navigation window   status bar   output window                  radar window 

 

3.1 Menu Bar  

Menu bar as shown below, it corresponds to some of the basic operation of software system. 

Each menu described below: 
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3.1.1 File Menu  

Menu Function Shortcuts 

Open Main macrocell New/Open top cell  

Close Close the active document  

Save Save the active document Ctrl + S 

Exit Exit the application  

3.1.2 Edit Menu  

Menu Function Shortcuts 

Undo Undo the last action U 

Redo Re-execute the last action Shift＋U 

Cut Cut the selection content Ctrl＋X 

Copy Copy the selected content Ctrl＋C 

Paste Insert Clipboard contents Ctrl＋V 

Copy to  Ctrl＋E 

Find Find the specified text Ctrl＋F 

Zoom In Enlarge the current view Ctrl＋Z 

Zoom Out Shrink the current view Shift＋Z 

Remove all ruler Clear all ruler Shift＋K 

Clear Pointed Element Delete by element type  

Highlight network Highlight network B 

Undo Highlight network Highlight Cancel Ctrl + B 

Extraction of  l / w Extraction length & width R 

3.1.3 View Menu  

Menu Function Shortcuts 

 Menubar Show or hide the menu bar  

 Toolbar Show or hide toolbars  

 Drawingbar Show or hide the drawing column  

 Blockbar Show or hide the BlockBar  

 Macrobar Show or hide the Macrobar  

 Symbolbar Show or hide the Symbolbar  

 Radarbar Show or hide the Radarbar  
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 Outputbar Show or hide the Outputbar  

 Browse window 1 Show or hide the browser window 1  

 Browse Window 2 Show or hide the browser window 2  

 Browse Window 3 Show or hide the browser window 3  

3.1.4 Tools Menu 

Menu Function Shortcuts 

Export Netlist Generated shematic data file  

Export CIF Generated l layout data file  

Check Design Rules Check design rules   

Refresh all cells Refresh cell  

Automatic Search Cell Automatic search cell instances   

Automatic Search Line Automatic search wire  

Repair Pin Connection Fix broken connection between  

Automatic Placement Pin Place PIN to an empty line head  

SVS schematic data comparison  

Make NetList Recalculate the logic relation  

Font Size Set font size  

All Move   

3.1.5 Options Menu  

Menu Function Shortcuts 

Settings Grid and automatic connection settings  

Display Settings display of each Figure   

Repeat Direction Setting naming repeat method  

Setting language   

3.1.6 Window Menu  

Menu Function Shortcuts 

 Cascade Arrange the windows to overlap  

 Tile Arrange windows as non-overlapping  

 Arrange Icons The icons at the bottom of the window  

 Project-(Macro) BLOCK Currently open window  

 Window Manage the current window  
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3.1.7 Help Menu  

 Menu Shortcuts 

About NetEditorLite Display program information, version number 

and copyright 

 

Check Update Find the highest version  

3.2 Tool Bar  

Some button icon of commonly command on the toolbar, each function of button icon and 

their corresponding Shortcut in the following table. 

 

 

Icon Function Shortcuts 

  Show / Hide Image ～ 

  Show all / selected objects F8、E 

  Add label F1 

  Add wire F2 

 Add junction  

  Add vdd instance F4 

  Add gnd instance F5 

  Add noConn instance F6 

  Add pin F7 

  Rectangle / Create Cell  

  Polygon/Create Cell  

  Add Ruler K 

  Delete DEL 

  Move screen  

  Coordinate positioning G 

  Enlarge Ctrl＋Z 

  Shrink Shift＋Z 

  Drag (remain the connection relationship)  

  Move (not remain connected relationship)  

  Copy   

  Rotation  

  Two selected points automatic connection  F3 
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3.3 Status Bar 

 

 

Background image          Coordinates of the current         Ruler Units,  

Load time                  mouse position                  micron or pixels 

 3.4 Multilayer image navigation bar  

 

 

The first layer image browser 

The second layer image browser 

window 

The third layer image browser 

window 
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3.5 Work window 

Work window shows the current position of the image, Switch to a different layer image by 

press the number keys  or ＇+＇、＇-＇. 

Press ~ to display or hide the background image. 
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3.6 Cell List 

 

 

                                       

      

 

Related operations: 

Click on "Name", "size", "Description" tab to make the appropriate sort. 

Double-click the cell name, open the corresponding cell. 

Right-click to display the menu below: 

Sorted by name

表 
Sorted by size 

Symbol cell list 

Macro cell list 
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3.7 Output window 

Output window record some result of the corresponding operation, such as pins on net, find, 

ERC etc. 

 

 

3.8 Radar window  

By radar navigation bar, user can clearly know the current cell in the entire chip image 

position. Also user can easily location position of the entire chip image by clicking on radar 

window. 
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Z 

   

 

 

  

The current position of the main 

view window 

Macrocells currently open 

window position 
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Chapter 4 Extraction process 

Electric circuit extracted by the following processes: 

1．Establish the top cell 

2.  Divided function module 

3.  Extraction within each function module 

4.  Electrical Rule Check (ERC)  

5.  Export  

4.1 Establish the top cell 

Main macro cell corresponding to the entire chip work area, it is the top cell.  Establish the 

main macro cell purpose is to future operations are limited to inside this master macro cell, 

including the establishment macro cells (function module) and symbol cells (component) . Main 

macro cell established according to the following methods: reduce the image to a suitable 

proportion, click on the toolbar  button, drawing an area, as shown in white border: 

  

In the pop-up "Tools Options" dialog, click the "New macro" and then in the pop-up "Cell 
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properties" dialog, click the "Save" button, as shown below.  In the "Cell properties" dialog, you 

can modify its Name property, or can also add RefPrefix parameter that are used as a prefix of 

instance name within cell .By this method, you can easily find out it belongs cell through the 

prefix of instance name. This example its Name property to BLOCK, RefPrefix parameter value is 

BL_, so in BLOCK cell all referenced names of instance are the beginning of  BL_.  

 

External cell in external library contains the symbolic figure geometric information and pins. 

It must be specified when exporting edf200 file. 

4.2 Divided Function modules 

According to working principle and electrical functions of various parts of the chip by image, 

the cell can be further divided into several macro cells (function module) and modules should not 

overlap each other. Division method has the same steps as establish the main macro cell 

A division of functional modules in top cell as show below: 
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 Main macro cell border        Macro cell (function module) border 

After the end of extraction of each functional module (Block1 or Block2 or Block3) in the top 

cell(BLOCK), you can put netlist data of instance that represent a functional module into the 

master Macro  by pop-up menu by right clicked on the boundary of instance as illustrated 

"Extract" . 

 

 

 

Block1 
Block2 

Block3 
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Before                                         After  

 

4.3 Extraction within each function module 

a) First, symbol cell (component) is defined by the various functional of the module. Symbol cell 

defined as follows: click on the toolbar button, draw boundary of cell, as shown: 
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In the pop-up "Tool Options" dialog, click the "Create Symbol", and modify its  

Property, and click "Save", as shown. 

 

b) Second, placing instances of cell by Automatic search cell command and manual 

confirmation or Manual placement instance (detailed reference to Chapter V). 

c) Third, drawing line by Automatic search cell command manual confirmation or Manual 

draw line (detailed reference to Chapter VI).  

d) Fourth, Electrical Rule Check. 

e) Finally, Generation of external pin that comprise a complete electric circuit. 

4.4 The net of specify wire 

Extraction of each functional module is over, you can view pins or wires on a net by 

right-clicked that pop-up menu and selected "list online wire "or "list online pin" on the specify 

wire. The result will be list the output window. Press TAB key one by one positioning view (press 

SHIFT + TAB back to the previous article). 
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You also can see the whole composition of net by double-click the specify wire, all wires and 

pins are listed, as shown below: 

 

4.5 Electrical Rule Check (ERC) 

Electrical rule checking should run at the end of extraction in each functional module. After 

By electrical rule checking, you can eliminate simple errors included in the circuit, as physical、

logical、reference name and so on (detailed reference to Chapter V). 

4.6 SVS 

In order to improve correct rate of the extraction data, we generally performed twice or more 

times extraction, then proceed comparison (SVS) between each other. Two or more times 

extraction should be based on the same reference cell data, then wires of extracting alone (Get the 

same reference cell data by save as). 
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4.7 Export  

Finally, you can export the electric circuit that extracted to file that can import to Synopsys, 

Cadence for redesign. Verilog, Edif200 format of file can be exported (detailed reference to 

Chapter VI) 

  



24 
 

Chapter 5 Check Design Rules 

Electrical rule checking should be check after extraction of each functional module finished 

and before export schematic data. By electrical rule checking, you can eliminate the circuit errors 

included reference name, physical and logic and so on. 

Click menu “Tools” -> "Check Design Rules" will pop up the following dialog: 

 

 

 

The selected items on dialog as shown above are checked after clicked the button "Check." 

The result will be displayed in the output window. Like with the previous operation, press Tab or 

SHIFT + Tab key to locate wrong location.  
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Chapter 6 Export schematic data 

Click the menu “Tools” -> "Export Netlist" will pop up the following dialog: 

 

 

Currently the output file format includes Verilog and Edif200. Click the "Export" will be 

generated in the specified format file. 

 

 

Re-specifies Ext-lib: Changed reference symbol of external library that is different form 
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created 

Corrdinate scaling: setting when cells are too dense or too sparse between each other. 

Export wire length: wire length in edif200. 
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Chapter 7 Export layout data 

According to schematic data that extracted, you can export brief layout data, and then import 

into LayoutEditor or Cadence to see Corresponding layout. 

7.1 Export CIF file 

In the menu bar "Tools", click "Export CIF ...", as shown below: 
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Correspondence between Schematic drawing layers and layout drawing layers file content is 

as follows:  

LayerMap CELLBOX Boundary 0.45 

LayerMap M1  MET1 0.45 

LayerMap M2  MET2 0.5 

LayerMap M3  MET3 0.5 

LayerMap  M4  MET4 0.5 

LayerMap  M5  MET5 0.5 

ViaMap  M1  M2      VIA1  

ViaMap  M2     M3      VIA2  

ViaMap  M3     M4      VIA3       

ViaMap  M4     M5      VIA4    

ViaParam VIA1  0.45    0.15 

ViaParam VIA2  0.45    0.15 

ViaParam VIA3  0.45    0.15 

ViaParam VIA4  0.45    0.15 

 

LayerMap: drawing layer convert keyword,  

Layer name of schematic、layer name of layout 、width of layout. 

  

ViaMap: via convert keyword, 

Abjacent layer name of schematic、via layer name of layout.  

 

Schematic drawing layers and layout 

drawing layers correspondence file path   
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ViaParam: via defined  keyword 

Layer name of via、width of via layer、Distance covered 

 

Note: case sensitive, a line must has a keyword 

 

7.2 Import data into Layout Editor  

Detailed reference to LayoutEditor user manual 

 

7.3 import data into Cadence  

     Detailed reference to LayoutEditor user manual 
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Chapter 8 About Setting Options 

Some setup options of the software is very important, such as color settings, grid settings, 

the following will be described one by one.  

8.1 Color Settings 

Clicked menu "Options" –>"Display", pop up a dialog about Display Options, as shown 

below. You can click "Add" to add a new layer lines, and set it to the corresponding style and 

direction attributes. 

 

 

Click on the tab "Line style definition", dialog will pop up as shown below. You can set the 

line name, color, style, line width and other attributes. By clicking "Add" you can increase the new 

line style. 
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Click on the tab "Layer Map" ,dialog will pop up as shown below. You can set the Image 

layer, Logic layer (Draw layer), and the Numeric shortcut keys. 
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8.2 Option settings 

Clicked menu "Options"-> "Settings", the following dialog will be displayed. In the "Grid 

Settings" tab, you can set precision and units of ruler. 

Users can precision of ruler by setting the grid spacing. 

When you need to use measuring the size of components, generally choose "unit is microns." 

 

 

"Auto wire Settings" tab as shown below. The options have the following meanings: 
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Check the "Auto-snap wires", the current mouse position from the nearest element is less 

than a certain threshold (default is 15 pixels, the user can modify), the line will automatically snap 

to the nearest element when drawing wire. 

Check the " List onLine pins when Double-click ", list all elements included pins connected 

line when double-click a line. 

Frequently Asked Questions 

Q1: After import edf200 file as below, although there is wire name, but no full connection, ask 

how to operate? Whether connect manually for the full connection? 

 

Re: 

Edf200 file exported form NetEditorLite, full wire was shortening into small wire, But 

retaining its logical connection relationship, as: M1_0, M2_0, M3_0 are representing a logical 

connection relationship by wire name. 

Because edf200 file without losing its logical connection relationship, it does not affect 

subsequent simulation and verification work. 
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Pictured below shown after manually structured circuit: 

 

Q2:Logical relationship disorders found, how to solve. 

Re: Run "Make Netlist" command 

 

Q3: How to quickly find the shorted connection points in the network 

Re: First list the network pin, and then in the output window, for as the following operation: 

 

  



35 
 

Appendix: Shortcuts 

Shortcut Icon Function 

Double-click the cell in Macro list or 

Symbol list 

 Open the cell 

Numeric keys as 1、2、3 …or  +、-   Switch different layers of image 

~  Show / Hide Image 

F8、 E  Show all / selected elements 

Arrow keys or W, A, S, D  Move the view up and down 

F1  Add label or wire name  

F2  Add wire 

F3   

F4  Add vdd Instance 

F5  Add gnd Instance 

F6  Add noConn Instance 

F7  Add Pin 

F3  Connect the two selected points  

DEL  Delete 

K  Add ruler  

Shift＋K  Clear ruler 

U  Undo the last operation 

Shift＋U  Re-execute the last action 

Ctrl＋X  Cut the selection to clipboard 

Ctrl＋C  Copy the selection to clipboard 

Ctrl＋V  Insert clipboard contents 

F  Find the specified text 

G  Loaction x,y 

Ctrl＋Z  Enlarge the current view 

Shift＋Z  Reduce the current view 

Ctrl + S  Save the active document 

B  Highlight the network 

Ctrl + B  Cancel highlighted network 

R  Extracting ruler value as cell’s parameter 

Ctrl + R  Extracting ruler value as instance’s parameter 

(First ruler as a parameter l value,  

Second ruler as the parameter w value) 

Q  Display template background 

 

 


